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Das Script darf ohne weitere Nachfragen frei verwendet werden. 
Diese Anleitung sollte beigelegt werden oder darauf hingewiesen werden. 
 
 
Modifikationen am Script sind unnötig und nicht erwünscht. 
Für Änderungswünsche bitte an mich wenden. ICQ#95176001 
Das Script ist durch das UrhG rechtlich geschützt! 
Es dürfen keine Teile davon unerlaubt kopiert werden. 
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Funktionsübersicht  
 

• Fernlichtschaltung ( Licht-Taste lang gedrückt halten für Fernlicht ) 
• Bremslicht 
• Rückfahrscheinwerfer 
• Blinker rechts/links (optional mit automatischer Abschaltung) 
• Warnblinkanlage 
• optionaler Blinkgeber-sound 
• Standlicht rechts/links ( Blinker anlassen beim Aussteigen ) 
• Standlicht Gesamtfahrzeug ( bei Option lightsStayOn ) 
• Tagfahrlicht (leuchtet entgegengesetzt zur Fahrzeugbeleuchtung) 
• Stroboskop-Blitzer (wahlweise mit definierter Blinksequenz oder zufällig) 
• Seperat schaltbare Arbeitslichter 
• Blinker,Rückfahrlicht und Bremslicht syncronisiert mit Zugfahrzeug 
• Blinkgeschwindigkeit syncronisiert mit Zugfahrzeug 
• Füllstandsabhängige Rundumleuchte für Drescher 
• Licht für das Abtankrohr von Dreschern (geht an beim Ausfahren des Rohres) 
• Standard Rundumleuchte erweitert für ausmodellierte Drehkörper 

 
Alle Lichter unterstützen 

• Angeschaltet bleiben beim Verlassen (auch für Standard Rundumleuchte) 
• Ersetzung realer Lichtquellen durch KI-Lichter im MP (für Andere) 
• Beliebig viele Lichter des gleichen Typs (zB mehrere Bremslichter) 
• Schaltersound 
• Volle Multiplayer-Tauglichkeit 
• SRS tauglich (macht das Fahrzeug selektierbar) 

 
Hinweis für die folgenden Anleitungen:  
 
Grau dargestellte XML Codes sind möglicherweise in ähnlicher Form bereits in der XML Datei vorhanden. In 
diesem Falle gehört der entsprechende Abschnitt innerhalb des grau dargestellten Codes.  
 
Blau dargestellte XML Codes werden nachfolgend genauer erläutert.



Anpassungen der moddesc.xml  
 
Als erstes sollte die Spezialisierung geladen werden:  
 
<specializations>  
    <specialization name="beleuchtung31" className="BEL3" filename="beleuchtungV31.lua"/>  
</specializations>  
 
Im Anschluss sollte – sofern dies noch nicht der Fall ist – ein neuer Fahrzeugtyp erstellt werden. 
Achtung! Es darf dafür kein vom Originalspiel verwendeter Typ genutzt werden. (tractor, trailer etc.) 
Das nachfolgende Beispiel beschreibt einen Drescher, man kann das Beleuchtungsscript aber auch auf 
andere Fahrzeugtypen anwenden.  
Die benötigten Spezialisierungen für andere Fahrzeugtypen lassen sich dem Wiki entnehmen: 
http://wiki.landwirtschafts-simulator.de/index.php/LS11_vehicleTypes_der_Originalfahrzeuge_und_Tools 
 
<vehicleTypes> 
    <type name="combine_cylindered_B31" className="Vehicle" filename="$dataS/scripts/vehicles/Vehicle.lua"> 
      <specialization name="motorized" /> 
      <specialization name="steerable" /> 
      <specialization name="cylindered" /> 
      <specialization name="combine" /> 
      <specialization name="hirable" /> 
      <specialization name="aiCombine" /> 
      <specialization name="honk" /> 
      <specialization name="beleuchtung31" /> 
   </type> 
</vehicleTypes> 
 
Wie man sieht sollte das Beleuchtungsscript als eines der letzten in die Liste aufgenommen werden.  
Der Name muss identisch zum Eintrag im Abschnitt <specializations> sein.  
 
Je nachdem welche Lichtfunktionen verwendet werden, kann es notwendig sein in der moddesc.xml noch 
Tastendefinitionen (InputBindings) sowie Hilfetexte (l10n) einzutragen.  
 
<inputBindings> 
    <input name="worklights" key1="KEY_KP_5" button="" /> 
    <input name="BEL3LEFT"  key1="KEY_KP_1" button="" /> 
    <input name="BEL3WARN"  key1="KEY_KP_2" button="" /> 
    <input name="BEL3RIGHT" key1="KEY_KP_3" button="" /> 
</inputBindings> 
 
Die nachfolgenden InputBindings sind fest vorgegeben wenn Blinker verwendet werden:  
BEL3LEFT : InputBinding für Blinker Links  
BEL3RIGHT : InputBinding für Blinker Rechts  
BEL3WARN : InputBinding für Warnblinkanlage  
 
Weitere InputBindings für die Arbeitslichter können hier vergeben werden. Es ist darauf zu achten das der 
angegebene Name mit dem Parameter inputName= des jeweiligen Arbeitslichtes überein stimmen muss. 
Achtung! Wenn bei verschiedenen Mods der gleiche Name für die InputBindings verwendet wird, dann 
werden diese Mods auch die gleichen Tasten verwenden – auch wenn in der moddesc.xml unterschiedliche 
Tasten zugewiesen sind. 
 
<l10n>  
   <text name="BEL3LEFT">  
      <de>Blinker links</de>  
      <en>left turnlights</en>  
   </text>  
   <text name="BEL3RIGHT">  
      <de>Blinker rechts</de>  
      <en>right turnlights</en>  
   </text>  
   <text name="BEL3WARN">  
      <de>Warnblinker</de>  
      <en>hazard lights</en>  
   </text>  
</l10n>  
 
Für jedes InputBinding sollte ein gleichnamiger l10n Text erstellt werden. Dies sorgt dafür, dass die 
Tastenkonfiguration auch in den Optionen des Spiels korrekt dargestellt wird.  
 



Anpassungen der Fahrzeug.xml  
 
Prinzipieller Aufbau des Eintrags:  
 
<lightsaddon lightsStayOn="true"> 
 <light type="highbeam" index="32|0" real="32|0|2" beam="32|0|1" /> 
 <light type="dirLeft" index="32|2" /> 
 <light type="dirRight" index="32|3" /> 
 <light type="reverse" index="32|7" /> 
 <light type="brake" index="32|8" /> 
 <light type="pipelight" index="0>7|2" /> 
 <fillLevelWarning percent="80" /> 
 <flashers soundfile="blinktick.wav" lowPitch="0.8" highPitch="1.0" volume="0.6"/> 
</lightsaddon> 
 
Parameter im Hauptzweig <lightsaddon> :  
 

• lightsStayOn=“[true|false]“ 
der Parameter ist optional. Die Vorgabe ist „false“ 
 
Bei „true“ bleibt die Standardbeleuchtung beim Verlassen des Fahrzeugs eingeschaltet. Sofern das 
Fahrzeug korrekt erstellt wurde, werden die Lichtquellen und die KI-Lichter abgeschaltet – es 
leuchten nur die Koronas. 
 

• blinkSpeed=“0.5“ 
der Parameter ist optional. Die Vorgabe ist „0.5“ 
 
Mit diesem Parameter kann die Blinkgeschwindigkeit angepasst werden. Die Angabe ist in 
Sekunden anzugeben und bezieht sich auf jeweils eine Phase. 
 

• modDirection=“[1|-1]“ 
der Parameter ist optional. Die Vorgabe ist „1“ 
 
Falls ein Mod verkehrt herum gebaut wurde kann es vorkommen das der Rückfahrscheinwerfer und 
die Bremsen während der normalen Vorwärtsfahrt aufleuchten. In diesem Falle sollte der Parameter 
auf „-1“ gesetzt werden um zu kennzeichnen dass das Fahrzeug in die andere Richtung fährt. 
 

• strobesAreBeacons=“[true|false]“ 
der Parameter ist optional. Die Vorgabe ist „false“ 
 
Bei true reagieren die Strobe-Blitzer wie Rundumleuchten. Die Angaben von inputName und helptext 
werden ignoriert da die Blitzer mit der Taste für die Rundumleuchte angehen. Sie reagieren dann 
auch auf die Füllstandswarnung oder auch wenn andere Scripts wie coursePlay die 
Rundumleuchten einschalten wollen. Es müssen dafür keine Rundumleuchten definiert sein. 

 
Parameter der einzelnen <light> Einträge:  
 

• type=“[…]“ 
der Parameter ist Pflicht. Es gibt keine Standardvorgabe 
 
Mögliche Angaben sind : 

o highbeam : Fernlicht 
o dirLeft : linker Blinker 
o dirRight : rechter Blinker 
o parkLeft : linkes Parklicht 
o parkRight : rechtes Parklicht 
o brake : Bremslicht 
o reverse : Rückfahrscheinwerfer 
o work : arbeitslicht 
o strobe : Blitzlicht 
o pipe : Beleuchtung Abtankrohr 
o drl : Tagfahrlicht 

 
Von jedem Typ können beliebig viele Einträge existieren. Einige der nachfolgenden Parameter  
sind nicht bei allen Lichttypen verfügbar.  



 
• index=“[…]“ 

der Parameter ist Pflicht. Es gibt keine Standardvorgabe. Verwendbar bei allen Typen. 
 
Beim index handelt es sich um den im Scenegraph des Giants Editors ausgezählten Index der 
jeweiligen Beleuchtung. Der index sollte auf die Korona bzw. die Leuchtquelle verweisen. Er wird 
vorrangig sichtbar/unsichtbar geschaltet. 
 

• real=“[…]“ 
der Parameter ist Optional. Es gibt keine Standardvorgabe. Verwendbar bei: work, highbeam, pipe 
 
hier wird der ausgezählte Index der realen Lichtquelle erwartet. Im Multiplayer wird diese Lichtquelle 
für andere Mitspieler ausgeblendet. Auch bei der Option „stayOn“ wird diese Lichtquelle unsichtbar 
geschaltet. 
 

• beam=“[…]“ 
der Parameter ist Optional. Es gibt keine Standardvorgabe. Verwendbar bei work, highbeam, pipe 
 
hier wird der ausgezählte Index des Lichtscheins erwartet. Der beam ist die stilisierte Darstellung 
des Lichtstrahls und wird anderen Spielern im Multiplayer anstatt der realen (real) Lichtquelle 
eingeblendet. 
 

• stayOn=“[true|false]“ 
der Parameter ist Optional. Standardvorgabe ist „false“. Verwendbar bei: work, strobe, pipe 
 
Wenn der Parameter auf „true“ steht, bleibt das Licht beim Verlassen des Fahrzeugs eingeschaltet. 
Sofern angegeben, wird dabei die Lichtquelle „real“ ausgeblendet. Es verbleibt nur das unter „index“ 
angegebene Objekt. 
 

• inputName=“[…]“ 
der Parameter ist Optional. Es gibt keine Standardvorgabe. Verwendbar bei: work, strobe 
 
Hier sollte bei schaltbaren Lichtern der Name des jeweiligen InputBindings – wie in der moddesc.xml 
definiert - angegeben werden. Ohne diese Angabe kann das Arbeitslicht nicht geschaltet werden. 
 

• helptext=“[…]“ 
der Parameter ist Optional. Es gibt keine Standardvorgabe. Verwendbar bei: work, strobe 
 
Bei schaltbaren Lichtern kann hier der Name des in der moddesc (Abschnitt l10n) definierten 
Hilfetextes angegeben werden. Es ist sinnvoll hier den selben Namen anzugeben wie bei 
inputName. Wenn der Parameter weg gelassen wird, erscheint kein Hilfetext. 

 
• sequence=“[.. .. .. ..]“ (type=“strobe“) 

der Parameter ist Optional. Es gibt keine Vorgabe. Beeinflusst nachfolgende Parameter 
 
Hier kann eine Blinksequenz angegeben werden. Die einzelnen Schaltzeiten werden in ms 
angegeben und durch ein Leerzeichen getrennt. Am Ende der Sequenz beginnt diese wieder von 
vorn. Wird dieser Parameter nicht angegeben, arbeitet das Blitzlicht im Zufallsmodus. 
 

• invert=“[true|false]“ (type=“strobe“) 
der Parameter ist Optional. Vorgabe ist „false“. Nur bei Angabe des Parameters „sequence“ 
 
Wenn der Parameter auf „true“ steht, beginnt die Sequenz mit einer Ausschaltphase. Dies ist primär 
gedacht um mehrere Blitzer versetzt schalten zu lassen. 
 

• minOn=“[…]“ & maxOn=“[…]“ (type=“strobe“) 
die Parameter sind Optional. Vorgabe für beide ist 100. Nur für den Zufallsmodus. 
 
Diese beiden Parameter definieren die minimale und maximale Dauer der Einschaltphase (in ms) im 
Zufallsmodus (also wenn „sequence“ nicht angegeben wurde) 
 

• minOff=“[…]“ & maxOff=“[…]“ (type=“strobe“) 
die Parameter sind Optional. Vorgaben sind 100 und 400. Nur für den Zufallsmodus. 
 
Diese beiden Parameter definieren die minimale und maximale Dauer der Ausschaltphase (in ms) im 
Zufallsmodus. 



Erweiterte Einträge im Hauptzweig: 
 

• <fillLevelWarning percent=“[...]“ /> 
der Eintrag ist Optional, der Parameter percent ist Pflicht. Es gibt keine Vorgabe. 
 
Hier kann man angeben bei wieviel Prozent Füllstand im Korntank die Rundumleuchte aktiviert 
werden soll. Diese Option funktioniert ausschliesslich bei Dreschern (combine). Wird der angegene 
Füllstand überschritten aktiviert sich selbstständig die Rundumleuchte. Sie kann manuell wieder 
deaktiviert werden. Wird der Füllstand unterschritten schaltet sich die Rundumleuchte wieder aus – 
vorausgesetzt sie wurde nicht manuell eingeschaltet. Dies funktioniert auch wenn der Drescher von 
einem Helfer gefahren wird. 
 

• <flashers soundfile="…" lowPitch="0.8" highPitch="1.0" volume="0.6" autoreturn="false"/> 
der Eintrag sowie alle Parameter sind Optional. 
 
Dieser Eintrag ermöglicht es weitere Angaben zu den Blinkern zu tätigen. Parameter: 

o soundfile=“…“ 
der Parameter ist Optional. Bei Nicht-Angabe werden Pitch und Volume ignoriert 
 
Wird ein Soundfile angegeben, so wird dieses als Sound für den Blinkgeber verwendet. 
Dabei wird der Sound bei jedem Phasenwechsel abgespielt. Er sollte daher in der Laufzeit 
kürzer sein als die Angabe blinkspeed= im Hauptzweig. 
 

o lowPitch=“[…]“ 
der Parameter ist Optional. Vorgabe ist „0.8“. Wird nur verwendet bei Angabe von soundfile. 
 
die Tonhöhe (Pitch) des Blinkgebers beim Wechsel in die Aus-Phase. 
 

o highPitch=“[…]“ 
der Parameter ist Optional. Vorgabe ist „1.0“. Wird nur verwendet bei Angabe von soundfile. 
 
die Tonhöhe des Blinkgebers beim Wechsel in die An-Phase. 
 

o volume=“[…]“ 
der Parameter ist Optional. Vorgabe ist „1.0“. Wird nur verwendet bei Angabe von soundfile. 
 
die Lautstärke in der der Blinkgeber-Sound abgespielt wird. 
 

o autoreturn=“[true/false]“ 
der Parameter ist Optional. Vorgabe ist „false“. 
 
Wenn dieser Parameter auf „true“ steht, wird der Blinker beim zurück drehen des Lenkrads 
in die Nullstellung wieder abgeschaltet. 
 

o tolerance=“[…]“ 
der Parameter ist Optional. Vorgabe ist „0.3“. Wird nur verwendet bei autoreturn=“true“ 
 
Hier kann mit einem Wert zwischen 0 und 1 definiert werden wie empfindlich die 
automatische Blinkerabschaltung reagieren soll. Bei 1 würde der Blinker nur nach einem 
vollen Lenkeinschlag abschalten.  
 

• <toggleSound file=“[…]“ pitch=“[…]“ volume=“[…]“/> 
der Eintrag sowie alle Parameter sind Optional 
 
Dieser Eintrag ermöglicht es den Sound für das Betätigen von Lichtschaltern anzupassen 

o file=“[…]“ 
das Soundfile welches verwendet wird. Standard ist „$dataS2/sounds/switchFlashlight.wav” 
 

o pitch=“[…]“ 
die Tonhöhe ( LS11 Standard = „0.5“ ). Vorgabe ist „1.0“ 
 

o volume=“[…]“ 
die Lautstärke des Sounds. Vorgabe ist „1.0“ 
 
 

 



Erweiterungen von Standard Einträgen der Fahrzeug XML: 
 

• <beaconLights stayOn="true"> 
Mit diesem Parameter bleiben die Standard Rundumleuchten beim Verlassen des Fahrzeugs 
eingeschaltet. 
 

• <beaconLight index="…" rotIndex="…" speed="…" /> 
Durch diesen optionalen Parameter bei Standard Rundumleuchten kann der Index eines 
Drehkörpers angegeben werden. In diesem Falle wird beim Einschalten der Rundumleuchte das 
unter „index“ angegebene Objekt sichtbar geschaltet und das unter „rotIndex“ angegebene Objekt 
rotiert. 

 
 
Hinweise zur Struktur im Modell (I3D) 
 
Arbeitslichter sowie das Fernlicht können in LS11 komplexer gestaltet werden. Das bedeutet man kann  
neben den eigentlichen Leuchtflächen und der Lichtquelle zusätzlich noch Koronas und Lichtmodelle wie  
bei KI Fahrzeugen angeben. Es bietet sich an diese ineinander zu verschachteln und alle Unterpunkte  
sichtbar zu schalten. Als Vorlage dient der Beispielmod RTS7545.  
 
[-] Licht (TransformGroup) 

[-] Lichtquelle (light) 
[-] Coronas (TransformGroup) 

Corona (Shape – Leuchtfläche) 
[-] Beams (TransformGroup) 

Beam (Shape – Lichtstrahl) 
  

Beigelegte Hilfsdateien 
 
Für diejenigen, die weniger Erfahrung im Modden haben und dennoch ihren Mod mit einer Beleuchtung 
ausstatten wollen, habe ich einige I3D Dateien dem Mod beigelegt (in Klammern stehen die Texturen die für 
diese I3D Dateien benötigt werden): 
 

• rundum.i3d (rundum.dds , corona_orange.dds , emissiveBillbordShader.xml) 
enthält das Modell einer Rundumleuchte mit seperatem Drehkörper. Diese kann in Verbindung mit 
dem aktuellen Script verwendet werden. 
 

• squarebeam.i3d (car_beam_diffuse.dds ) 
enthält das Modell eines einzelnen Lichtscheins (KI-Licht) um Arbeitslichter damit auszustatten. 
 

• flasher.i3d (flasher.dds) 
enthält das Modell eines Stroboskop-Blitzers für Einsatzfahrzeuge. 
 

• beleuchtung.i3d (car_beam_diffuse.dds , corona_orange.dds , car_corona_red_diffuse.dds , 
car_corona_white_diffuse.dds , emissiveBillbordShader.xml) 
 
enthält das komplette Beleuchtungs-Set des V3.0 Beispielmods „AgroX720B3“ zum einfachen 
Import in den eigenen Traktor. 



Schnellimport für einen Traktor 
 
Um das Beleuchtungsscript schnell und einfach in einen Traktor zu integrieren empfehle ich , die folgenden 
Dateien in den Ordner des eigenen Traktors zu kopieren :  
 
beleuchtung.i3d 
car_beam_diffuse.dds 
car_corona_red_diffuse.dds 
car_corona_white_diffuse.dds 
corona_orange.dds 
emissiveBillbordShader.xml 
 
Dann den eigenen Traktor im GE öffnen und mittels File->Import die beleuchtung.i3d importieren. 
Anschliessend die importierte TransformGroup „beleuchtung“ anklicken und im Menü Edit->Cut anklicken. 
Daraufhin das oberste Objekt im Scenegraph des GE anklicken und im Menü  Edit->Paste wählen. 
Nun muss der Index zur TransformGroup „beleuchtung“ ausgezählt oder ab GE 4.1.8 hinter „Index Path“ 
abgelesen werden. Die XML Einträge kann man sich aus dem Beispielmod zu Beleuchtung V3 
(Downloadlink: http://ul.to/u30kuz oder bei Modhoster) entnehmen. 


